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概要

InformaCast Virtual Appliance Basic Paging（InformaCast または Basic InformaCast）は、仮想化環境

において、Cisco IP Phone にライブ オーディオ ストリームに配信するための、Singlewire Software の 
IP テレフォニーのブロードキャスト システムです。InformaCast は、大規模なグループがメッセージ

をすばやく受け取れるように設計されています。InformaCast を介してこれらのメッセージが送信され

る場合、これをブロードキャストと呼びます。

このマニュアルは、InformaCast を最大限活用するために必要な最も一般的な作業の実行方法をいくつ

か紹介し、迅速に開始できるようにすることを目的としています。このマニュアルの各項の詳細につい

ては、InformaCast の [Help] > [Install Guide] からオンライン ヘルプに進むか、[Help] > [Support] か
ら PDF 形式で、『InformaCast Virtual Appliance Installation and User Guide』を参照してください。

環境

このマニュアルには 3 種類のバージョンがあり、Basic Paging（基本ページング）を使用したインス

トールについて、Advanced Notification（高度な通知）と Cisco Unified Communications Manager を
組み合わせたインストール、そして Advanced Notification と Hybrid Runtime Environment（HRE）を

組み合わせたインストールがあります。カバー ページまたは、ページの下に表示される環境の種類を

確認して、適切なバージョンを使用しているかどうか確認してください。

InformaCast の機能はライセンスに基づいて、ユーザの持つライセンスによって異なり、InformaCast 
の機能のすべてまたは一部にアクセスできます。Basic InformaCast 機能では、Cisco IP Phone の番号

にコールを発信することによって、最大 50 台の電話機に音声のライブ ブロードキャストが可能です。

Advanced InformaCast 機能には、様々な種類のブロードキャスト（ライブ音声、あらかじめ録音され

た音声、あらかじめ録音された音声およびテキストなど）を配信する機能があります。これらでは、

Cisco IP Phone のインターフェイスや InformaCast の Web インターフェイスを使用して、InformaCast 
のプラグイン（電話会議の運営、コンタクトの終了、Facebook および Twitter への投稿、電子メール 
アドレスへのブロードキャストの配信）と連携し、ブロードキャストに添付できるスクリプトをカスタ

マイズして、ブロードキャストが他の機能に配信されたときに確認を受け取ります。

（注） InformaCast を Basic から Advanced へアップグレードするには、[Try] または [Buy] アイコンから簡

単に実行でき、または機能を切り替えるのためのライセンスを入手するために Singlewire に問い合わ

せることで実行できます。Advanced InformaCast から Basic へ戻す場合は、InformaCast の [Manage 
License Key] ページ（[Admin] > [Manage License Key]）の [Stop Advanced Notification Trial] ボタン

をクリックして実現されます。これによって InformaCast がリブートし、InformaCast functionality の
機能またはライセンス タイプが変更されます。

Basic および Advanced 機能に加えて、InformaCast では、ベーシック、試用版、デモンストレーショ

ン、サブスクリプション、または購入したライセンスを取得できます。基本ライセンスは Basic 
InformaCast 機能にのみ適用され、永続的に存在します。その他のライセンスは、Advanced 
InformaCast にのみ適用され、Singlewire Software から取得することができます。
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第 1 章
概要
詳細については、『InformaCast Virtual Appliance Installation and User Guide』の「A Note on 
Licensing」を参照してください。

前提条件

InformaCast ではシステムが次の前提条件を満たしている必要があります。

• 『InformaCast Virtual Appliance Installation and User Guide』で定義されるハードウェア要件を満

たす

• 次のサポートされているブラウザを使用：Firefox 15、Chrome 18、または Internet Explorer 9

• InformaCast と電話機の間のすべてのネットワーク セグメントでマルチキャスト ルーティングを

有効化および設定する

• InformaCast virtual appliance のスタティック IP アドレスを設定する

• Cisco Unified Communications Manager サーバ（Business Edition 6000 を含む）のインストール

とメンテナンス。次のバージョン 8.5、8.6、9.0、および 9.1 がサポートされます。

• InformaCast を使用するすべての Cisco IP Phone の Web アクセスを有効化する

• Communications Manager クラスタ内のすべてのサーバで SNMP を有効化する

• Communications Manager クラスタ内の少なくとも 1 台のサーバ上で AXL サービスを実行する 

• CallManager サービスを実行している少なくとも 1 つのノード上で CTIManager サービスを実行す

る CTIManager サービスはクラスタ内の最大 8 ノードで稼働し、このサービス冗長性のために複数

のノードを使用する必要があります。

• InformaCast サーバのコマンドライン インターフェイス（bash プロンプト）へのアクセス、基本

的な UNIX コマンドの実行、ファイルを編集するための vi の使用方法 に関する知識

ヒント Singlewire は少なくとも 1024x768 の画面解像度を推奨します。

トラブルシューティング

マニュアルの入手方法、テクニカル サポート、その他の有用な情報について、次の URL で、毎月更新

される『What's New in Cisco Product Documentation』を参照してください。シスコの新規および改訂

版の技術マニュアルの一覧も示されています。
http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

また、『InformaCast Virtual Appliance Installation and User Guide』も参照してください。
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InformaCast のインストール

このアプリケーションは、概念の多くが VMware ESXi および Communications Manager の知識を必要

とするため、Communications Manager に精通した ESXi の管理者がインストールし、インストール手

順の一環として両方の設定をする必要があることが想定されます。

マルチキャスト環境の準備

（注） InformaCast を設定する前に、次の推奨事項に従ってください。InformaCast 環境は安定しているため、

設定はスムーズに進みます。

受信者が InformaCast ブロードキャストの音声部分を受信するようにネットワーク全体でマルチキャス

トを有効にする必要があります。

注意 これは、電話機での保留音がマルチキャストを使用しているわけではないためです。保留音は、ユ

ニキャストまたはマルチキャストとして使用できます。

マルチキャストは、ネットワーク内の 1 人の送信者と複数の受信者との間の通信です。InformaCast は
マルチキャストの有効化方法について特別な要件はないので、ネットワーク ベンダーのベスト プラク

ティスおよび設計上の考慮事項を使用してください。マルチキャストは、スパース モードまたはデン

ス モードで配置されている Protocol Independent Multicast（PIM）でルーティングされます。

InformaCast はどちらのモードでも動作します。

回線のプロバイダーがマルチキャストをルーティングしない WAN リンクでは、GRE トンネルを設定

して、InformaCast サーバがある場所からマルチキャスト トラフィックを伝送します。これらの GRE 
トンネルを通過する必要があるトラフィックは、ルーティングするマルチキャスト トラフィックだけ

です。トンネルは、サイト間のフル メッシュを作成する必要はありません。これらは、ハブからス

ポークの場所に設定する必要があります。詳細については、次のリンクを参照してください。
http://www.cisco.com/en/US/tech/tk828/technologies_configuration_example09186a00801a5aa2.shtml 

受信者が InformaCast ブロードキャストの音声部分を受信するために、インターネット グループ管理

プロトコル（IGMP）を使用してリクエストを行います。ほとんどのネットワークがデフォルトで 
IGMPv2 を設定しますが、新しい受信者が IGMPv3 を使用する場合があります。新しい受信者が配置

される場合、ネットワーク デバイスで新しいプロトコル バージョンを有効にする必要があります。

ネットワーク設計とマルチキャスト設定は、Singlewire が提供するサポートの対象外です。ネットワー

ク ベンダーまたはパートナーと連携することが推奨されます。Cisco ネットワークの場合、Cisco TAC 
または現地のシスコのパートナーと連携することができます。
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Communications Manager の統合

テレフォニー環境で InformaCast の使用を開始する前に、Communications Manager のバージョンを設

定する必要があります。

警告 Basic InformaCast で Communications Manager の設定ができなかった場合、Advanced 
InformaCast をアップグレードした際に Basic InformaCast にもう一度ダウングレードする前に 
Communications Manager を設定することが求められます。そうでない場合、この項の手順をも
う一度繰り返す必要があります。

ステップ 1 Web ブラウザを開き、Communications Manager サーバの管理インターフェイスにログインします。

ステップ 2 Communications Manager クラスタ ノード上で次の Cisco CallManager、Cisco TFTP、Cisco 
CTIManager、Cisco AXL Web Service、Cisco CallManager SNMP Service サービスを有効にして

ください。

（注） Cisco CallManager SNMP Service、Cisco AXL Web Service、Cisco CTIManager を 
Communications Manager クラスタで有効にする必要があります。  

ステップ 3 読み取り専用（ReadOnly）アクセス権を持つ InformaCast という名前の SNMP コミュニティ ストリ

ングを作成します。可能な場合、[すべてのノードに適用（Apply to All Nodes）] チェックボックスを

選択します。

ステップ 4 リージョンを作成して InformaCast という名前を付けて、（電話機をブロードキャストするその他すべ

ての電話機のリージョン同様に）リージョン領域で InformaCast を選択し、[オーディオ コーデック

（Audio codec）] ドロップダウン メニューから [G.711] を選択します（Communications Manager 9.x 
以降では、[最大オーディオビットレート（Maximum Audio Bit Rate）] ドロップダウン メニューから 
[64kbps (G.722, G.711)] を選択します）。

ステップ 5 デバイス プールを作成して InformaCast という名前を付けて、先ほど作成した InformaCast リージョ

ンに追加します。

ステップ 6 ルート パーティションを作成し、InformaCast という名前を付けます。

（注） 電話機が使用するコーリング サーチ スペースにこのパーティションを追加してください。追加

しない場合、電話機が InformaCast のルート ポイントに到達できません。

ステップ 7 ルート ポイントを作成し、InformaCast という名前を付け、[デバイス プール（Device Pool）] ド
ロップダウン メニューから InformaCast を選定し、ルートポイントまでの回線を追加して、DN を割

り当て（ユーザが DialCasts を開始するために使用する番号）、[ルート パーティション（Route 
Partition）] ドロップダウンメニューから InformaCast を選択して、[表示（内線発信者 ID）（Display 
(Internal Caller ID)）] および [ASCII 表示（発信者 ID）（ASCII Display (Caller ID)）] フィールドに 
InformaCast と入力します。

（注） 電話機が使用するコーリング サーチ スペースに InformaCast パーティションを追加します。追

加しない場合、電話機からこれらの内線番号にダイヤルできません。

ステップ 8 コーリング サーチ スペースを作成し、InformaCast という名前を付けます。このコーリング サーチ 
スペースに電話機のパーティションを追加します。InformaCast CTI ポートはレコード音声オーディオ

に電話を設置する場合は、このコーリング サーチ スペースを使用します。
2
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ステップ 9 CTI ポートを作成します。InformaCast デバイス プール、コーリング サーチ スペース、およびデバイ

ス セキュリティ プロファイルとして Cisco CTI Port - Standard SCCP Non-Secure Profile を選択しま

す。

（注） ほとんどの組織では 1 つのポートのみ必要です。さらに必要な場合は、InformaCast、
InformaCast2、InformaCast3 などの番号付け方式を使用します。

ステップ 10 CTI ポートにディレクトリ番号 (DN) を追加し、組織内で他の目的で使用されず、Direct Inward 
Dialing（DID; ダイヤルイン）の範囲外の DN を選択します。 InformaCast ルート パーティションを選

択し、[表示（内線発信者 ID）（Display (Internal Caller ID)）] および [ASCII 表示（発信者 ID）

（ASCII Display (Caller ID)）] フィールドに InformaCast と入力します。

ステップ 11 ユーザ グループを作成して、これに InformaCast AXL User Group という名前を付け、Standard 
AXL API Access ロールを割り当てます。

ステップ 12 InformaCast ブロードキャスト用のアプリケーション ユーザを作成し、これに InformaCast という名

前を付け、ルート ポイントおよび [Controlled Devices] 領域で作成した CTI ポートを追加し、ユーザ

を次の、Standard CTI Enabled、InformaCast AXL User Group、Standard CTI Allow Control of 
Phones supporting Connected Xfer and conf、Standard CTI Allow Control of Phones supporting 
Rollover Mode グループに追加します。

ステップ 13 InformaCast を使用する電話機に割り当てられた電話プロファイルで、[Web アクセス（Web Access）] 
ドロップダウン メニューを [有効（Enabled）] に設定するか、Web アクセスをデバイス レベルで有効

にします。

ステップ 14 電話機をリセットします。

（注） これらの変更を確定させるには、電話機をリセットする必要があります。ただし、

「InformaCast の設定」（P.3-1）でも電話機をリセットする必要があります。電話機の数が多い

場合、この手順には時間がかかります。電話機をもう一度リセットする場合は、デフォルトの 
Communications Manager クラスタの設定が完了するまでは作業を実施しないでください。

InformaCast Virtual Appliance のインストール

InformaCast Virtual Appliance をインストールするには、次の手順を実行します。

（注） Singlewire は、VMware ESXi 4.0 以降のプラットフォーム上で InformaCast Virtual Appliance をサ

ポートしています。このプラットフォームは、vSphere クライアントによって管理されます。ここで

は、vSphere クライアントを使用して InformaCast Virtual Appliance をインポートする方法について説

明します。

ステップ 1 OVA ファイルを、Singlewire の Web サイトまたはシスコの Web サイトからダウンロードします。

（注） Communications Manager Business Edition 6000 上で InformaCast を使用する場合は、OVA を
伴うパッケージが DVD で提供されます（物理メディア）。

ステップ 2 vSphere Client を開き、ログインします。
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ステップ 3 [File] > [Deploy OVF Template] の順に選択します。

ステップ 4 [Deploy from File] オプション ボタンをクリックし、[Browse] ボタンをクリックします。

Singlewire-InformaCast-VM.ova ファイルの保存場所（または提供された DVD 上の OVA ファイル）

に移動してファイルを選択し、[Open] ボタンをクリックします。

ステップ 5 [Next] ボタンを 3 回クリックします。

ステップ 6 新しい仮想マシンが存在するデータストアを選択して、[Next] ボタンをクリックします。

ステップ 7 [Finish] ボタンをクリックします。InformaCast Virtual Appliance がインポートを開始します。作業が

完了したら、[Close] ボタンをクリックします。

ステップ 8 vSphere クライアント ウィンドウで [Inventory] アイコン（ ）をクリックし、仮想マシンを選択し

ます（デフォルトでは、Singlewire InformaCast VM です）。

ステップ 9 [Inventory] > [Virtual Machine] > [Open Console] に移動します。

ステップ 10 緑色の矢印ボタン（ ）をクリックして、仮想マシンを起動します。Singlewire InformaCast VM コ
ンソール ウィンドウが仮想マシンの起動を開始します。

InformaCast Virtual Appliance の起動が完了すると、（使用可能な DHCP サーバが存在する場合）

DHCP を使用して IP アドレスを取得します。

（注） Singlewire は InformaCast Virtual Appliance のスタティック IP アドレスを設定することを推奨

します。IP アドレスとパケット ルーティングの指定に関しては、ネットワーク管理者に確認し

てください。

InformaCast VA OVA ファイルをダウンロードして、ファイルを展開し、仮想マシンにコンソールウィ

ンドウを開くと、SwiftStart が自動的に開始します。

（注） SwiftStart は InformaCast Virtual Appliance の初期ブート時に限り自動的に起動します。

ステップ 11 エンド ユーザ使用許諾契約書（EULA）を承認するには、[I agree] ボタンをクリックします。

ネットワークで DHCP が有効な場合は、[Use DHCP Parameters] または [Enter Manually] オプション 
ボタンのどちらかを選択することが可能です。

• [Use DHCP Parameters] オプション ボタンを選択して [Submit] ボタンをクリックすると、

SwiftStart は IP アドレスをスタティックにして、この IP アドレスから関連するネットワーク設定

情報を取得し、InformaCast を使用するようにネットワークを設定します。ステップ 13に進みま

す。

• [Enter Manually] オプション ボタンを選択して [Submit] ボタンをクリックすると、IP アドレスを

手動で入力することができます。引き続き、次の手順を実行します。

ステップ 12 現在ネットワークで使用されていないルーティング可能な IP アドレス、その IP アドレスの有効なネッ

トマスク、デフォルトゲートウェイ、ネットワーク上の DNS サーバの IP アドレスを入力し、[Submit] 
ボタンをクリックします。

ネットワーク設定が成功すると、[Network Configuration] ページは成功したことを示すステートメン

トを表示してリフレッシュされます。

ステップ 13 [Finish] ボタンをクリックします。SwiftStart ウィンドウで、InformaCast が開始したことが示されます。

ステップ 14 開いているコンソール ウィンドウを閉じます。
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InformaCast の開始

（注） 「InformaCast Virtual Appliance のインストール」（P.2-3）の SwiftStart の手順がすべて完了したら、す

でに InformaCast が開始しているので、「InformaCast へのログイン」（P.2-5）に進むことができます。

「InformaCast Virtual Appliance のインストール」（P.2-3）の SwiftStart の手順がすべて完了していなけ

れば、InformaCast はまだ開始されていません。InformaCast を始めて開始した後（そして起動時の問

題が問題がない場合）、仮想マシンが起動すると自動的に起動するようになります。

（注） 混乱を回避するために、初めて InformaCast を開始する前に InformaCast の IP アドレスを静的に設定

してください。

ステップ 1 Web ブラウザを開いて、InformaCast Virtual Appliance サーバの IP アドレスを入力し、Enter キーを押

します。Singlewire 開始ページが表示されます。

ステップ 2 [Access System Management Tools with Webmin] リンクをクリックします。Webmin ページのタブ /
ウィンドウが新しく表示されます。Singlewire 開始ページのタブ /ウィンドウは開いたままにしておき

ます。

ステップ 3 ログイン クレデンシャルを入力して、[Login] ボタンをクリックします。デフォルトでは、ユーザ名は 
admin、パスワードは changeMe です。

ステップ 4 [System] > [Bootup and Shutdown] システムに移動し、singlewireInformaCast にたどり着くまでアク

ションの一覧をスクロールダウンしてリンクをクリックし、[Start Now] ボタンをクリックします。

InformaCast の開始には数分程かかります。これ以降、InformaCast は、仮想マシンの起動時に自動的に

開始します。

InformaCast へのログイン

Singlewire 開始ページには、仮想アプライアンス サーバの IP アドレスで Web ブラウザを介してアク

セスでき、アプリーケーションのユーザ インターフェイス、ツールボックスおよび Webmin へのリン

クが含まれています。

ステップ 1 Web ブラウザを開いて、InformaCast Virtual Appliance サーバの IP アドレスを入力し、Enter キーを押

します。Singlewire 開始ページが表示されます。

ステップ 2 [InformaCast] リンクをクリックします。InformaCast 開始ページのタブ /ウィンドウが新しく表示され

ます。InformaCast を始めて開始する場合、システムによっては InformaCast が初期化されるまで数分

かかることがあります。

ステップ 3 [Login] フィールドに admin そして [Password] フィールドに changeMe と入力して InformaCast にロ

グインします。
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InformaCast の設定

インストールを最適化するには、InformaCast ソフトウェアのいくつかの側面をカスタマイズし、

JTAPI を更新する必要があります。

InformaCast サーバの設定

InformaCast をインストールしたら、InformaCast と Communications Manager との統合を設定する必

要があります。

ステップ 1 [Admin] > [Telephony] > [CUCM Cluster] に移動し、[Default Configuration] の横にある [Edit] ボタン

をクリックします。

ステップ 2 [Communications Manager Application User] フィールドで、アプリケーション ユーザのユーザ名を入

力します。ステップ 12（P.2-3）でこのユーザを作成しています。

ステップ 3 アプリケーション ユーザのパスワードを [Communications Manager Application Password] および 
[Confirm Application Password] フィールドに入力します。

ステップ 4 InformaCast の電話機のキャッシュを構築する場合にアプリケーション ユーザ クレデンシャルが使用

されることを示す、[Use Application User for AXL] チェックボックスが選択されていることを確認し

ます。

ステップ 5 [AXL IP Address(es)] フィールドに AXL IP アドレスを入力します。アドレスはカンマで区切ります。

このフィールドを空欄にすると、InformaCast は CallManager サービスを実行しているサーバ間で 
AXL サービスを実行するサーバを見つけようとします。

ヒント Communications Manager にログインして、[ナビゲーション（Navigation）] ドロップダウン 
メニューから [Cisco Unified Serviceability] を選択して [ツール（Tools）] > [サービス アク

ティベーション（Service Activation）] に移動し、どのクラスタ メンバーが AXL サービスを

実行しているかを確認できます。[Cisco AXL Web Service] チェックボックスが選択されるか

どうか確認するには、[Service Activation] ページをスクロールダウンします。

ステップ 6 [Communications Manager IP Address(es)] フィールドで Communications Manager サーバ（複数可）

の IP アドレスを入力すると、Communications Manager との CTI（JTAPI）接続を確立する際に使用

されます。CTI Manager サービスを実行しているあらゆる Communications Manager を入力できます。

DNS 名ではなく数値の IP アドレスを使用します。

注意 InformaCast Basic Paging では、Communications Manager のバージョンが 8.5 以降である必要があ

ります。[Edit Telephony Configuration] ページのフィールドに入力し [Update] ボタンをクリックす

ると、InformaCast は [Communications Manager IP Address(es)] フィールドで入力した内容に基づ

いて Communications Manager のバージョンを特定します。Communications Manager 8.5 以降を

使用する場合、InformaCast Basic Paging を使用し続けることができます。Communications 
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Manager 8.5 以前のバージョンでは、次のオプションのどちらかを選択できます。[Try] アイコンを

クリックすると InformaCast Advanced Notification の 60 日間の無料試用期間が開始し、[Buy] ア
イコンをクリックすると InformaCast Advanced Notification のデモンストレーション、サブスクリ

プション、または購入済みライセンスが入手できます。

ステップ 7 [SNMP Community Name] および [Confirm SNMP Community Name] フィールドに適切な名前を入力

します（ステップ 3（P.2-2）を参照してください）。

ステップ 8 InformaCast ウィンドウを開いたまま新しいウィンドウを開き、Communications Manager にログイン

します。

ステップ 9 [システム（System）] > [エンタープライズ パラメータ（Enterprise Parameters）] に移動します。

ステップ 10 ページを [電話の URL パラメータ（Phone URL Parameters）] セクションまでスクロールダウンして、

[URL 認証（URL Authentication）] フィールドの現在の値を確認してください。InformaCast が [Edit 
Telephony Configuration] ページで表示するとおりの値を使用してください。  

ステップ 11 Communication Manager の [URL 認証（URL Authentication）] フィールドの値を、InformaCast の 
[Edit Telephony Configuration] ページの [XML Push Authentication] 中に表示される値に変更します。

これは通常、http://<InformaCast Server IP Address>:8081/InformaCast/phone/auth という形式に

なります。

（注） Communications Manager 8.x 以降を使用する場合、[セキュア認証 URL（Secured 
Authentication URL）] にもこの IP アドレスを入力する必要があります。

ステップ 12 Communications Manager の変更を保存するには [保存（Save）] ボタンをクリックします。

（注） 新しい認証 URL を反映するには、電話機を再起動してください。　 

ステップ 13 InformaCast の [Telephony Configuration] ページで [Update] ボタンをクリックします。

ステップ 14 [refresh the Recipient Group] リストのリンクをクリックして、受信者のグループのリストを更新しま

す。

ステップ 15 [Update] ボタンをクリックします。

ステップ 16 [Update] ボタンをもう一度クリックします。

JTAPI のアップデート

基本機能を確認したら、InformaCast で使用される JTAPI ライブラリを Communications Manager で
使用されるものと同じバージョンに更新する必要があります。

ステップ 1 Web ブラウザを開いて、InformaCast Virtual Appliance サーバの IP アドレスを入力し、Enter キーを押

します。Singlewire 開始ページが表示されます。

ステップ 2 [Access System Management Tools with Webmin] リンクをクリックします。Webmin ページのタブ /
ウィンドウが新しく表示されます。
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ステップ 3 ログイン情報を入力します。デフォルトでは、ユーザ名は admin、パスワードは changeMe です。

ステップ 4 [System] > [Bootup and Shutdown] システムに移動し、singlewireInformaCast にたどり着くまで、アク

ションの一覧をスクロールダウンしてリンクをクリックし、[Stop Now] ボタンをクリックします。

InformaCast の停止には数分程かかります。

（注） このウィンドウを開いたままにします。これについては後で説明します。

ステップ 5 InformaCast のコマンドライン インターフェイスにアクセスするために、PuTTY などの SSH クライア

ントを使用します。次の手順では PuTTY インターフェイスを使用します。

ステップ 6 [Host Name (or IP address)] フィールドに、InformaCast の IP アドレスを入力し、[Port] フィールドは

デフォルトの 22 のままにして、[SSH] オプション ボタンをクリックし、[Open] ボタンをクリックし

ます。

ステップ 7 プロンプトで、admin と入力し、Enter キーを押します。

ステップ 8 プロンプトで、changeMe と入力し、Enter キーを押します。

ステップ 9 プロンプトで、updateJTAPI と入力し、Enter キーを押します。

ステップ 10 プロンプトで exit と入力し、Enter キーを押します。

ステップ 11 [Stop Action] ページに戻り、[Return to action] リンクをクリックします 

ステップ 12 [Start Now] ボタンをクリックします。InformaCast の開始には数分程かかります。
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InformaCast の使用

効果的に InformaCast を使用するには、次の用語を理解すると役に立ちます。

• ブロードキャストは電話機に送信される音声メッセージです。

• メッセージには、ブロードキャストされる音声およびブロードキャストを受信する受信者が含まれ

ます。

• 受信者は、デジタル電話などのエンドポイントです。複数の受信者は、受信者のグループに編成で

きます。

受信者のグループの追加

より小規模な受信者のグループ（システム内のすべてのエンドポイントではなく）にメッセージを送る

場合、InformaCast で適切な受信者のグループを設定する必要があります。

（注） デフォルトでは、InformaCast は最初に「（すべての受信者）グループ」を作成し、これには検出する

ことのできるすべての受信者が含まれます。

ステップ 1 [Recipients] > [Edit Recipient Groups] に進みます。このページは、各グループの電話機の数を示しま

す。

ステップ 2 [Add] ボタンをクリックし、受信者のグループに名前を付け、受信者を個別に選択してメンバーを追加

するかルールを設定することで追加するかを決定します（複数選択の 3 番目の選択肢である既存の受信

者のグループは、受信者のグループを作成した後に限り利用可能で、詳細については『InformaCast 
Virtual Appliance Installation and User Guide』で説明しています）。

• 受信者の選択を選んだ場合、[Individually] チェックボックスを選択して [Edit] ボタンをクリック

し、表示される [Select Individual Recipients] ポップアップウィンドウで [Available Recipients] 領
域から [Selected Recipients] 領域へ受信者を移動します。[Filter] フィールドにテキストを入力し

て、リストをフィルタリングします。このテキストはP.4-2の表で説明されている制約の値になり

ます。選択内容を保存するには、[Submit] ボタンをクリックします。

• ルールを作成する場合は、[Filter with Rules] チェックボックスを選択して [Edit] ボタンをクリッ

クし、受信者をマッチさせるまたはマッチさせない、および受信者のグループから包含または除外

するかを決定するルールを作成するために、ドロップ ダウン メニューおよびフィールドを使用し

ます。ルール パラメータについては、次の表で説明します。
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マッチング パラメータ 説明

Communications Manager Calling Search 
Space 

指定のサーチ スペースに一致する（または一致し

ない）電話機。a 

Communications Manager Cluster Name 指定の Communications Manager クラスタ名に一

致する（または一致しない）電話機。

Communications Manager Device Pool 指定のプールに一致する（または一致しない）電

話機。

Communications Manager Device Type Communications Manager サーバによって報告さ

れた指定のモデルに一致する（または一致しな

い）電話機。

制約として等号を選択した場合、人間指向のモデ

ル名を持つドロップダウン メニューが表示されま

す。そうでない場合は、シスコによって割り当て

られた基盤となる数値コードで番号が表示されま

す。

Can Display Text テキスト表示する機能に一致する（または一致し

ない）受信者。テキストを表示できる受信者は通

常、IP フォンです。b

Description 指定の説明に一致する（または一致しない）受信

者。これはシステム内の受信者の説明を制御でき

るため、グループ化するプロセスを容易にするた

めに説明をセットアップすることができ、有用な

グループ化ツールです。

ユーザが入力したテキストは Communications 
Manager サーバに登録された電話機の [デバイス

の説明（Device Description）] エントリと比較さ

れます。指定したルールに説明が一致する受信者

は、受信者のグループの一部と見なされます。

Directory Numbers Communications Manager サーバに割り当てられ

た指定の電話番号に一致する（または一致しな

い）電話機。b

IP Address 指定のサブネット境界に一致する（または一致し

ない）受信者。このパラメータを選択すると、新

しく [Belong to Subnet] という [Comparison 
Type] を選択でき、ここでは 172.17.30.0/8 のよう

なサブネット マスクを入力できます。この方法の

詳細については、『InformaCast Virtual Appliance 
Installation and User Guide』の「Subnet 
Matching」を参照してください。

InformaCast Device Type IP フォンの機能が一致する（または一致しない）

受信者。

Location 指定の場所の値に一致する（または一致しない）

受信者。

MAC Address ネットワーク上で一意であることが保障された受

信者のネットワーク ハードウェア アドレスに 一
致する（または一致しない）受信者。
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ステップ 3 受信者のグループを作成し終わったら、[Update] ボタンをクリックします。受信者のグループが 
InformaCast に追加されます。

新しいメッセージの追加

メッセージは InformaCast、ブロードキャストの基礎となります。メッセージは、ブロードキャストの

特性を定義します。

メッセージはテキスト、音声、またはその両方で構成できますが、Basic InformaCast 機能では、ライ

ブ オーディオ ブロードキャストにのみアクセスできます。　　 これらのメッセージでは、録音は一切

されません。また、メッセージがブロードキャストされると受信者のグループにリアル タイムでスト

リーミングします。ブロードキャストが発生したとき、これらのブロードキャストは使用中の電話機で

はスキップされ、音声を再生できるすべての受信者がブロードキャストを再生する準備ができるまで待

機し、ブロードキャストが発生した際は電話機で設定されている音量で再生します。同時にブロード

キャストを予定している場合、最初のブロードキャストが初めに再生されます（2 番目のブロードキャ

ストは予約を取り消されます）。

Name 指定の名前に一致する（または一致しない）受信

者。[Description] パラメータと同様に、名前を制

御するためグループ化に有用ですが、簡潔な名前

にしておく必要がありします。

Partition Names 各電話番号に割り当てられるダイヤル プラン 
パーティションに一致する（または一致しない）

電話機。つまり、 Communications Manager で IP 
フォンに割り当てられている電話番号。

Profile Description Communications Manager のユーザ デバイス プ
ロファイルの説明に一致する（または一致しな

い）電話機。ログアウト時に、エクステンション 
モビリティまたはプロファイルを使用する電話機

はこの方法でフィルタリングすることができま

す。このオプションは、Communications 
Manager v6 以降を使用する場合に限り使用でき

ます。

a. 警告：エクステンション モビリティを使用する場合は、電話機に割り当てられるコーリング サーチ スペー

スおよび電話番号もユーザがログインする際に変更する可能性があることに留意してください。このため、

Communications Manager コーリング サーチ スペースを（個人ではなく）地域区分を反映することを想定

した受信者のグループの設定基準としての使用を避ける必要があります。このような地域区分には、IP アド

レスがエクステンション モビリティが要因の場合に適しています。

b. このパラメータに一致させるには、受信者が現在登録されている必要があります。InformaCast には、未登

録の受信者の詳細な機能に関する情報は存在しません。

マッチング パラメータ 説明
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[Messages] アイコンをクリック、または [Messages] > [Send or Edit Messages] に進みます。[Send or 
Edit Messages] ページが表示されます。

（注） Basic InformaCast 機能では、潜在的に存在するすべての InformaCast メッセージを確認できますが、

Advanced InformaCast 機能を利用するまで設定できません。Advanced InformaCast ライセンスを入手

するには Singlewire に問い合わせて、無料試用版または購入を選択し、すべての InformaCast 機能へ

アクセスできるようにします。

潜在的な InformaCast メッセージの確認の他には、[View] ボタン（実行中のブロードキャストがある

ときに [Send or Edit Messages] ページ上にのみ表示されます）をクリックすることで実行中のブロー

ドキャストを確認し、実行中のブロードキャストをキャンセルすることが可能です。

SIP 機能の管理

（注） この項の作業を完了するには、SIP の知識が必要です。疑問点がある場合は、『InformaCast Virtual 
Appliance Installation and User Guide』でより広範な説明を参照ください。

Session Initiation Protocol（SIP）は、多数の PBX とテレフォニー デバイスでサポートされ、

InformaCast に SIP コールを受信する機能を提供し、他の SIP デバイスが InformaCast を見つけ、コー

ルできるようにします。

SIP 機能の設定により、InformaCast と通信するために SIP および SIP デバイスを使用することで、

Communications Manager を使用せずに DialCast 機能にアクセスできるようになります。必要に応じ

て、Communications Manager を使用することもできます。

SIP 機能を設定するには、SIP トランクおよび InformaCast の [SIP] ページを設定する必要があります。

SIP トランクの設定

（ステップ 7（P.2-2）で作成した）Communications Manager のルート ポイントを CTI または JTAPI と
組み合わせる代わりに InformaCast でテレフォニー通信に SIP を使用する場合、SIP トランク セキュリ

ティ プロファイル、SIP トランク、ルート パターンの 3 つの基本コンポーネントを持つ SIP トランク

を作成する必要があります。

（注） 次の項では、Communications Manager 7.0 以降で使用する必要があります。

ステップ 1 Communications Manager サーバの管理インターフェイスを開き、ログインします。

ステップ 2 [システム（System）] > [セキュリティ プロファイル（Security Profile）] > [SIP トランク セキュリ

ティ プロファイル（SIP Trunk Security Profile）] の順に移動し、[検索（Find）] ボタンをクリックし

ます。

ステップ 3 デフォルト プロファイルの行の [非セキュア SIP トランク プロファイル（Non Secure SIP Trunk 
Profile）] で [コピー（Copy）] アイコンをクリックし、SIP トランク セキュリティ プロファイルの一

意の名前を入力し、IP トランク セキュリティ プロファイルの説明を入力し、[デバイス セキュリティ 
モード（Device Security Mode）] ドロップダウン メニューから [非セキュア（Non Secur）] を選択し

ます。
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（注） お使いの環境で TLS プロトコルを使用する場合は、ここで説明されるとおり SIP トランクを作

成し、「TLS プロトコルを促進する SIP 証明書の管理」（P.4-7） の手順を実行します。

ステップ 4 [発信転送タイプ（Outgoing Transport Type）] ドロップダウン メニューから [TCP] または [UDP] を選

択して、[着信ポート（Incoming Port）] を 5060 のままにし、[保存（Save）] ボタンをクリックしま

す。

（注） このポート番号を変更すると、新しいポートの着信トラフィックを許可するように 
InformaCast Virtual Appliance のファイアウォールを変更する必要があります。この変更に関

してヘルプが必要がな場合は、サポート担当者まで問い合わせてください。

ステップ 5 [デバイス（Device）] > [トランク（Trunk）] に移動し、[新規追加（Add New）] ボタンをクリック

します。

ステップ 6 [トランク タイプ（Trunk Type）] ドロップダウン メニューから [SIP トランク（SIP Trunk）] を選択

し、[デバイス プロトコル（Device Protocol）] ドロップダウン メニューに [SIP] が選択肢として表示

されていることを確認し、[次へ（Next）] ボタンをクリックします。

ステップ 7 SIP トランクの名前を入力して、ステップ 5（P.2-2）で作成したデバイス プールを選択し、[インバウ

ンドコール（Inbound Calls）] 領域までスクロール ダウンしてステップ 8（P.2-2）で作成したコーリン

グ サーチ スペースを選択します。[SIP 情報（SIP Information）] 領域までスクロール ダウンして [接
続先アドレス（Destination Address）] フィールドにお使いの InformaCast サーバの IP アドレスを入力

します。

ステップ 8 [接続先ポート（Destination port）] フィールドの値がステップ 4（P.4-5）に示されるものと同じであ

ることを確認し、作成した SIP トランク セキュリティ プロファイルを選択して、[SIP プロファイル

（SIP Profile）] ドロップダウン メニューから [標準（Standard）] を選択します。

ステップ 9 [保存（Save）] ボタンをクリックします。

ステップ 10 [コール ルーティング（Call Routing）] > [ルート /ハント（Route/Hunt）] > [ルート パターン（Route 
Pattern）] に移動し、作成した SIP トランクを使用するルート パターンを作成します。

ステップ 11 [新規追加（Add New）] ボタンをクリックし、[ルートパターン（Route Pattern）] フィールドにルー

ト パターンを入力して、ステップ 6（P.2-2）で作成したルート パーティションを選択し、ルート パ
ターンの説明を入力して、作成した SIP トランクを選択し、[このパターンをルーティング（Route 
This Pattern）] オプション ボタンを選択します。

ステップ 12 [保存（Save）] ボタンをクリックします。

（注） Communications Manager ウィンドウを開いたままにします。これについては後で説明します。

InformaCast への SIP アクセスを許可または無効にする

SIP アクセスは着信 SIP コールを許可または拒否します。　 

（注） SIP への変更はただちに有効になり、InformaCast を再起動する必要はありません。

ステップ 1 InformaCast を開き、ログインします（「InformaCast へのログイン」（P.2-5）を参照してください）。
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ステップ 2 [Admin] > [SIP] > [SIP Access] に移動して、[Allow] オプション ボタンを選択して SIP コールを許可

します。

ステップ 3 許可される SIP コールに例外を追加するには、[Add] ボタンをクリックします。

ステップ 4 [Host] フィールドに SIP アクセスから除外するホストの IP アドレスまたは完全修飾ドメイン名を入力

します。

ヒント 例外を定義する場合、InformaCast に直接 INVITE 要求を送信するホストを指定してください。

これは、プロキシが InformaCast と発信ホストとの間にあるとき、SIP プロキシ サーバである

場合があります。

ステップ 5 変更を保存するには、[Add] ボタンをクリックして、[Update] ボタンをクリックします。

（注） InformaCast ウィンドウを開いたままにします。これについては後で説明します。

InformaCast の SIP 認証の有効化

（注） この項は、お使いの環境のセキュリティによっては省略できます。

SIP 認証では、着信 SIP 要求のダイジェスト認証を有効化または無効化します。

ステップ 1 Communications Manager サーバの管理インターフェイスを開き、ログインします。

ステップ 2 [ ユーザ管理（User Management）] > [SIP レルム（SIP Realm）] に移動し、[ 検索（Find）] ボタンをク

リックします。設定された SIP レルムを示す [SIP レルムの検索 / 一覧表示（Find and List SIP Realms）] 
ページが表示され、SIP レルムを設定していない場合には行は何も表示されません。

使用したい SIP レルムがある場合、それを選択して [SIP レルムの設定（SIP Realm Configuration）] 
ページの [レルム（Realm）]、[ユーザ（User）]、[ダイジェスト信用証明書（Digest Credentials）] 
フィールドに表示される値を書き留めます。ステップ 6（P.4-6） にスキップします。

レルムが設定されていない場合、次の手順を実行します。

ステップ 3 [新規追加（Add New）] ボタンをクリックし、次の値を入力します。

• [レルム（Realm）] フィールドに InformaCast

• [ユーザ（User）] フィールドに sipuser

• [ダイジェスト信用証明書（Digest Credentials）] フィールドに changeMe

• [ダイジェスト信用証明書の確認（Confirm Digest Credentials）] フィールドに changeMe

ステップ 4 [保存（Save）] ボタンをクリックします。

ステップ 5 InformaCast ウィンドウに戻ります。

ステップ 6 [Admin] > [SIP] > [SIP Authentication] に移動し、[Authenticate Incoming Requests] チェックボックス

を選択して SIP 認証を有効にします。
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（注） このページのフィールドは事前に入力されています。これらを変更する場合に限り、設定を編

集する必要があります。

ステップ 7 [Realm]、[Authentication Username]、[Authentication Password]、[Confirm Authentication Password] 
フィールドの値が Communications Manager の [SIP レルムの設定（SIP Realm Configuration）] ページ

で入力または書き留めた値（それぞれ [レルム（Realm）]、[ユーザ（User）]、[ダイジェスト信用証明

書（Digest Credentials）]、[ダイジェスト信用証明書の確認（Confirm Digest Credentials）]）と一致し

ていることを確認します。

ステップ 8 InformaCast が単一の認証要求を許可する期間を [Nonce Duration] ドロップダウン メニューから選択

します。

ステップ 9 [Update] ボタンをクリックして、変更を保存します。

SIP ユーザ クレデンシャルでダイジェスト認証を有効化する

（注） この項は、お使いの環境のセキュリティによっては省略できます。

SIP ピアは SIP コールの登録または終了の際に SIP レルムに有効なクレデンシャルを提供するために 
InformaCast にチャレンジします。InformaCast がチャレンジされる予想される各 SIP レルムの有効な

クレデンシャルを入力する必要があります。

ステップ 1 [Admin] > [SIP] > [SIP Authentication] に移動し、[Add] ボタンをクリックします。

ステップ 2 SIP ピアの SIP レルムの名前、SIP ピアの SIP レルムに関連するユーザ名およびパスワードを入力し、

[Add] ボタンをクリックします。

TLS プロトコルを促進する SIP 証明書の管理

（注） この項は、お使いの環境のセキュリティによっては省略できます。

TLS プロトコルは SIP エンドポイント間にセキュア シグナリングを提供するために SIP で使用されま

す。InformaCast 証明書が、InformaCast で SIP 転送プロトコルとして TLS を使用する各ホストにダウ

ンロードおよびインストールされていることが必要です。また、同様のホストからの証明書が 
InformaCast にアップロードされることも重要です。また、TLS を使用するセキュリティ プロファイ

ルを変更する必要があります。

（注） InformaCast の SIP 証明書は、[Admin] > [SIP] > [SIP Authentication] に移動し、[View] ボタンをク

リックして確認できます。

ステップ 1 SIP デバイス上に InformaCast SIP 証明書をインストールするには、[Admin] > [SIP] > [SIP 
Authentication] に移動して、[Download] ボタンをクリックし、[Save] ボタンをクリックします。

Communications Manager サーバがアクセス可能な場所を選択し、[Save] ボタンをクリックします。
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（注） このウィンドウを開いたままにします。これについては後で説明します。

ステップ 2 Communications Manager ウィンドウに戻り、[ナビゲーション（Navigation）] ドロップダウン メ
ニューから [Cisco Unified OS の管理（Cisco Unified OS Administration）] を選択し、[移動（Go）] 
ボタンをクリックして、OS 管理インターフェイスにログインします。

ステップ 3 [セキュリティ（Security）] > [証明書の管理（Certificate Management）] に移動し、[証明書のアップ

ロード（Upload Certificate）] をボタンをクリックします。

ステップ 4 [証明書の名前（Certificate Name）] ドロップダウン メニューから [CallManager-信頼

（CallManager-Trust）] を選択し、[参照（Browse）] ボタンをクリックして、InformaCast.pem ファイ

ルを保存した場所に移動してそれを選択し、[開く（Open）] ボタンをクリックします。

ステップ 5 [証明書のアップロード（Upload Certificate）] ウィンドウで [ファイルのアップロード（Upload File）] 
ボタンをクリックし、[閉じる（Close）] ボタンをクリックします。

ステップ 6 SIP トランクによって使用されている各 Communications Manager サーバに対してこの手順を実行しま

す。

（注） TLS 証明書は、Communications Manager がインストールされる際に再生成されます。このた

め、サーバをバックアップからリストアする場合、これらの手順を再度実施する必要がありま

す。また、InformaCast 証明書は InformaCast がインストールされる際または IP アドレスが変

更される際に再生成されるため、この手順は InformaCast が再インストールまたは IP アドレス

が変更される場合に再度実施する必要があります。

ステップ 7 [ナビゲーション（Navigation）] メニューから、[Cisco Unified CM の管理（Cisco Unified CM 
Administration）] を選択し、[実行（Go）] ボタンをクリックし、管理インターフェイスにログインす

ることによって TLS を使用する SIP トランクのセキュリティ プロファイルを変更します。

ステップ 8 [システム（System）] > [セキュリティ プロファイル（Security Profile）] > [SIP トランク セキュリ

ティ プロファイル（SIP Trunk Security Profile）] の順に移動し、[検索（Find）] ボタンをクリックし

ます。

ステップ 9 SIP トランク セキュリティ プロファイルの名前のリンクをクリックし、そして [デバイス セキュリ

ティ モード（Device Security Mode）] ドロップダウン メニューから [暗号化済（Encrypted）] を選択

し、[発信転送タイプ（Outgoing Transport Type）] メニューから [TLS] を選択し、[X.509 の件名

（X.509 Subject Name）] フィールドに InformaCast-<x.x.x.x> と入力し、<x.x.x.x> の部分は 
InformaCast に割り当てられる共通名の IP アドレス セクションに差し替え、[着信ポート（Incoming 
Port）] フィールドには 5061 と入力して [保存（Save）] をクリックします。

ステップ 10 [デバイス（Device）] > [トランク（Trunk）] に移動し、[検索（Find）] ボタンをクリックして TLS 
によって使用される SIP トランクを変更します。

ステップ 11 SIP トランクの名前リンクをクリックし、[SIP 情報（SIP Information）] までスクロールダウンして、

[接続先ポート（Destination Port）] フィールドに 5061 と入力し、[保存（Save）] ボタンをクリック

して [リセット（Reset）] ボタンをクリックします。

ステップ 12 [ナビゲーション（Navigation）] ドロップダウン メニューから [Cisco Unified OS の管理（Cisco 
Unified OS Administration）] を選択して InformaCast 上に SIP デバイス証明書をインストールし、[移
動（Go）] ボタンをクリックして OS 管理インターフェイスにログインします。

ステップ 13 [セキュリティ（Security）] > [証明書の管理（Certificate Management）] に移動し、[検索（Find）] 
をボタンをクリックします。

ステップ 14 [.PEM ファイル（.PEM File）] 列で [CallManager.pem] リンクをクリックし、InformaCast サーバがア

クセス可能な場所に .pem ファイルをダウンロードします。
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（注） InformaCast と通信する 14各 Communications Manager サーバから手順を実行します 12。

ステップ 15 InformaCast ウィンドウに戻ります。

ステップ 16 [Admin] > [SIP] > [SIP Authentication] に移動し、[Upload] ボタンをクリックします。[Browse] ボタ

ンをクリックして、CallManager.pem ファイルを保存した場所に移動してそれを選択し、[Open] ボタ

ンをクリックします。[Upload] ボタンをクリックします。

ステップ 17 ダウンロードした各 CallManager.pem ファイルにステップ 16 の手順を実行します。

（注） アップロードおよび削除も含めた InformaCast の証明書キャッシュに変更は、反映する前に 
SIP を再起動する必要があります。

ステップ 18 [Admin] > [SIP] > [SIP Authentication] に移動し、[Restart] ボタンをクリックします。SIP が再起動する

までに数分かかることがあります。

注意 SIP を再起動するとすべての SIP コールがドロップされ、DialCast IVR とやりとりする発信者は自

身のコールをドロップします。SIP コールを使用するブロードキャストも、再起動の影響を受けま

す。SIP コールを使用するライブ ブロードキャストは停止します。

SIP スタックの管理

InformaCast は、NIST（国立標準技術研究所）SIP スタックを使用して基本的な SIP 機能を提供しま

す。SIP スタック（[Admin] > [SIP] > [SIP Stack]）は、トランザクションの処理、ダイアログ、SIP 
ヘッダーのためのユーティリティ、SIP タイマーのメンテナンスなどの基本的な低レベルの SIP 機能を 
InformaCast に提供します。

注意 容量の大きいログ ファイルの生成およびさまざまなロギングによりスタック パフォーマンスが低下

するため、SIP スタックの詳細ロギングを有効化する場合は注意してください。詳細ログは、SIP 
の問題のトラブルシューティング時に限り使用することを目的としており、必要がないときには有

効にしないでください。InformaCast ログ ディレクトリに、sipStackDebug.log および 
sipStackServer.log の 2 つのログ ファイルが成されます。

（注） このページのほとんどの値は変更する必要はありません。最も変更する可能性が高い値は、SIP ポート

番号および詳細ログのチェックボックスです。

次のフィールドおよびドロップダウン メニューから [SIP Stack] ページにアクセスできます。

• [UDP/TCP Port]。SIP スタックが UDP または TCP トランスポート プロトコルを使用する着信要

求をリッスンするポート番号。

• [TLS Port]。SIP スタックが TLS プロトコルを使用する着信要求をリッスンするポート番号。
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（注） UDP および TCP の標準 SIP ポートは 5060 です。TLS の標準ポートは 5061 です。必要に応

じてスタックは標準以外のポートを使用するように設定できます。このポート番号を変更する

と、新しいポートの着信トラフィックを許可するように InformaCast Virtual Appliance のファ

イアウォールを変更する必要があります。この変更に関してヘルプが必要がな場合は、サポー

ト担当者まで問い合わせてください。

• [Enable Detailed Logging]。SIP スタックのログ出力レベルを制御します。チェックすると、SIP 
スタックのアクティビティの広範で詳細なログが有効になり、パフォーマンスも低下する可能性が

あります。チェックしない場合、ロギングは SIP スタックで発生した問題および通常のアクティビ

ティの報告に限定されます。サポート担当者から説明がない限り、このチェックボックスはチェッ

クしないことが推奨されます。

• [Max Forwards]。SIP メッセージが宛先へルーティングされている間転送が許可される最大数。

• [Read Timeout]。TCP 接続の読み取りのタイムアウト（ミリ秒）。

• [Cache Client Connections]。終端状態に達したときに SIP スタックがクライアント トランザク

ションに関連するリソースを解放するかを制御します。チェックすると、SIP スタックが終了した

ときにトランザクションのリソースをキャッシュするため、SIP スタックのパフォーマンスが向上

します。

• [Cache Server Connections]。終端状態に達したときに SIP スタックがサーバ トランザクション

に関連するリソースを解放するかを制御します。チェックすると、SIP スタックが終了したときに

トランザクションのリソースをキャッシュするため、SIP スタックのパフォーマンスが向上しま

す。

変更を行った場合は、[Update] ボタンをクリックするか [Restore] ボタンをクリックしデフォルト設定

に戻します。

注意 SIP を再起動する必要があります。SIP を再起動するとすべての SIP コールがドロップされ、

DialCast IVR とやりとりする発信者は自身のコールをドロップします。SIP コールを使用するブ

ロードキャストも、再起動の影響を受けます。SIP コールを使用するライブ ブロードキャストは停

止します。

SIP の再起動

SIP スタックまたは証明書に対して変更すると、反映するために再起動が必要です。アクセスおよび認

証などのその他の SIP の変更は、変更が行われるとすぐに有効になります。

注意 SIP を再起動するとすべての SIP コールがドロップされ、DialCast IVR とやりとりする発信者は自

身のコールをドロップします。SIP コールを使用するブロードキャストも、再起動の影響を受けま

す。SIP コールを使用するライブ ブロードキャストは停止します。

ステップ 1 [Admin] > [SIP] > [Restart SIP] に移動します。

ステップ 2 [リスタート（Restart）] ボタンをクリックします。SIP が再起動するまでに数分かかることがありま

す。
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 DialCast 機能の設定

InformaCast の DialCast 機能は InformaCast ブロードキャストをトリガーするルート ポイントまたは 
SIP 番号にダイヤルします。ダイヤル番号に対応したダイヤリング パターンの設定は、どの 
InformaCast メッセージを送信する必要がありどの受信者のグループがメッセージを受信するかを指定

します。

ダイヤリング パターンは、ダイヤルする番号に基づいてどの受信者のグループが使用されるかを指定

します。

ステップ 1 [Admin] > [DialCast] > [Dialing Configurations] に移動し、[Add] ボタンをクリックし、[Dialing 
Pattern] フィールドに InformaCast で監視されるルート ポイントに対するダイヤリング パターン

（8811 など）を入力します。これは、ステップ 7（P.2-2）で作成したルート ポイントと同じです。

InformaCast で監視する各ルート ポイント回線に、少なくとも 1 つのダイヤリング パターンの設定を

追加する必要があります。

ヒント ダイヤル パターンの設定に「*」または「#」を使用可能ですが、InformaCast がワイルドカー

ドとして処理できるように文字の前に「\」を追加する必要があります。たとえば、**1 はダイ

ヤル パターンにすると \*\*1 となります。

ステップ 2 受信者のグループまたは [Select Recipient Groups] フィールドからグループを選択します。

ステップ 3 現在のダイヤリング パターンの設定を保存するには、[Add] ボタンをクリックします。

ステップ 4 セット アップ内容に応じてダイヤル パターンにダイヤルし、ブロードキャストが開始されて適切な受

信者のグループに送信されます。

ブロードキャストの送信

ヒント ブロードキャストを送信する前に、ルート ポイント（ステップ 7（P.2-2）参照）または SIP トランク

（「SIP トランクの設定」（P.4-4）参照）と同じように DialCasts を設定する必要があります（「DialCast 
機能の設定」（P.4-11）参照）。

Basic InformaCast 機能には、ブロードキャストとしてライブ オーディオ メッセージを送信する機能が

あります。Advanced InformaCast 機能には、4 つの異なるブロードキャストのカテゴリにグループ化

される 8 種類のメッセージがあります。

• テキスト、テキストおよび録音済みのオーディオ、録音済みのオーディオ メッセージ

• テキストおよびライブ オーディオおよびライブ オーディオ メッセージ

• テキストおよびアドホックオーディオおよびアドホックオーディオメッセージ

• 通話とメッセージの再生

（注） Advanced InformaCast 機能の詳細については、Singlewire Software にお問い合わせください。
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ライブ オーディオ ブロードキャストを送信するには、ブロードキャスト ダイヤル設定に対応した 
Cisco IP Phone の電話番号にコールを発信します（「DialCast 機能の設定」（P.4-11）参照）。これは、

Communications Manager のルート ポイント（ステップ 7（P.2-2）参照）または SIP トランク（「SIP 
トランクの設定」（P.4-4）参照）のどちらかに接続しています。コールが処理され、ただちにブロード

キャストのダイヤル設定で指定されるすべての受信者がアクティブ化され（すでに使用中の電話機を除

く）、ライブをブロードキャストします。

トラブルシューティング

サポートで最初に利用できるのが [Help] アイコンです。このボタンをクリックすると、オンライン ヘ
ルプ システムが表示されます。ドロップダウン メニューにアクセスすると、次にアクセスすることが

できます。

• オンライン ヘルプ システム

• FAQ セクション

• トラブルシューティング セクション

• InformaCast のサポート ページ

PDF 形式の『InformaCast Virtual Appliance Installation and User Guide』は、[Help] > [Support] から

アクセスします。
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5

InformaCast を Basic から Advanced へアップグレード
する

InformaCast の機能はライセンスに基づいて、ユーザの持つライセンスによって異なり、InformaCast 
の機能のすべてまたは一部にアクセスできます。Basic InformaCast 機能では、Cisco IP Phone の番号

にコールを発信することによって、最大 50 台の電話機に音声のライブ ブロードキャストが可能です。

Advanced InformaCast 機能には、様々な種類のブロードキャスト（ライブ音声、あらかじめ録音され

た音声、あらかじめ録音された音声およびテキストなど）を配信する機能があります。これらでは、

Cisco IP Phone のインターフェイスや InformaCast の Web インターフェイスを使用して、InformaCast 
のプラグイン（電話会議の運営、コンタクトの終了、Facebook および Twitter への投稿、電子メール 
アドレスへのブロードキャストの配信）と連携し、ブロードキャストに添付できるスクリプトをカスタ

マイズして、ブロードキャストが他の機能に配信されたときに確認を受け取ります。

InformaCast のユーザはすべて、Basic InformaCast から開始して、[Try] または [Buy] アイコンから、

または機能を切り替えるためのライセンスを入手するために Singlewire に問い合わせることで、

Advanced InformaCast にアップグレードできます。

（注） Advanced InformaCast から Basic へ戻す場合は、InformaCast の [Manage License Key] ページ

（[Admin] > [Manage License Key]）の [Stop Advanced Notification Trial] ボタンをクリックして実現

されます。これによって InformaCast がリブートし、InformaCast functionality の機能またはライセン

ス タイプが変更されます。

Basic および Advanced 機能に加えて、InformaCast では、ベーシック、試用版、デモンストレーショ

ン、サブスクリプション、または購入したライセンスを取得できます。InformaCast ライセンスの詳細

については、『InformaCast Virtual Appliance Installation and User guide』を参照してください。

ヒント InformaCast の Advanced Notification（高度な通知）の詳細を確認する場合は、[Learn] アイコンをク

リックしてアップグレードによって利用可能な拡張機能の詳細情報を提供する Singlewire Software の 
Web サイトにアクセスしてください。

バージョンに関する注意事項

InformaCast で Basic から Advanced へのアップグレードまたは Advanced から Basic へのダウング

レードする際に留意すべき警告があります。

• ベーシック、試用版、デモンストレーション、サブスクリプション、または購入したライセンスを

利用して、InformaCast を Basic から Advanced にアップグレードして、その後 Basic 機能に戻す

場合は、Advanced 機能で入力したすべての追加情報は保存されません（Advanced から Basic に
戻す際、最初にアップグレードした後で入力した、ダイヤリング、設定、ユーザ、受信者のグルー
1
InformaCast Virtual Appliance Basic Paging

Version 8.4

mailto:sales@singlewire.com


 

第 5 章
InformaCast を Basic から Advanced へアップグレードする
プなどのすべての情報は Basic InformaCast にダウングレードした後では利用できません）。

Advanced InformaCast への再アップグレードを行う場合、情報が再度表示されますが、Basic 機能

に戻った後で新しく入力した情報は利用できません。

• Singlewire の営業担当者から提供される有効なライセンスキーが必要です（Advanced 
InformaCast の試用版を使用している場合、ライセンスキーがすでに含まれています）。受け取っ

ていない場合は、sales@singlewire.com までお問い合わせください。

• （以前 Advanced InformaCast を利用していて）Basic InformaCast から Advanced InformaCast へ
移行する場合、InformaCast は新しいライセンスのインストールにともなって再起動します。適切

なアップグレードの計画を行ってください。

• Basic および Advanced InformaCast には違いがあるため、インストールおよびユーザ ガイドが 2 
つ存在します。Basic InformaCast から Advanced InformaCast にアップグレードする場合、

Advanced InformaCast の機能を含む新しいガイドを入手する必要があります。新しいガイドを受

け取っていない場合は、Singlewire Software までお問い合わせください。

• InformaCast の Web インターフェイスは、Basic から InformaCast へのへの変更により、新しいメ

ニューと豊富な機能が追加され、大幅に変更されます。アクセス レベルによって、次へアクセス

ができます。

– [Home] をクリックします。InformaCast のホーム画面、RSS ニュースフィードで構成されま

す。

– [Messages]。メッセージの管理ページ、ブロードキャスト用のメッセージを作成、編集、送信

できます。

– [Recipients]。受信者グループの管理ページ、受信者のグループを作成および管理することが

できます。

– [Speakers]。IP スピーカーの管理ページ、IP スピーカーの検出、追加、編集、テスト、リッ

スンができます。

– [Bells]。ベルのスケジュールの概要ページ、呼出音リスト、ベルのスケジュール、作成済みの

例外にアクセスできます。

– [Admin]。設定の概要ページ。スケジュールしたアップデートおよびバックアップの表示、ラ

イセンスキー、音声メニュー、ユーザの管理、DialCast に伴うシステム、ネットワーク、ブ

ロードキャスト パラメータの設定ができます。

– [Plugins]。プラグインの管理ページ、プラグインの追加、無効化および有効化、そして設定

にアクセスすることができます。

– [Help]。InformaCast のヘルプ ページ、さまざまなオンライン ヘルプ システムにアクセスで

き、サポートのリクエストを入力することが可能です。

• Basic InformaCast でパスワードを変更して、Advanced InformaCast をアップグレードし、その後 
Basic InformaCast へダウングレードした場合、パスワードは Basic InformaCast の元のパスワード

に戻ります。

• Basic および Advanced InformaCast の切り替えを計画していて IP アドレスを変更する場合、

InformaCast OVA を再配置する必要があります（参照「InformaCast Virtual Appliance のインス

トール」（P.2-3））。

• Basic InformaCast で Communications Manager の設定に失敗した状態で、Advanced InformaCast 
にアップグレードして、その後 Basic InformaCast にダウングレードする前に Communications 
Manager を設定した場合は、「Communications Manager の統合」（P.2-2）の手順をすべて繰り返

す必要があります。

アップグレードに関して疑問がある場合は、「トラブルシューティング」（P.5-5）を参照してください。

それ以外の場合は、オンライン サポート リクエスト フォームから Singlewire サポートにお問い合わせ

ください。次の情報を含めます。
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• アカウントの担当者情報

• メンテナンス契約番号：

• 問題の詳しい説明

• 製品名とバージョン

• Communications Manager のバージョン

• InformaCast ログ。https://<InformaCast Server IP Address>:8444/InformaCast/logs/ に記録されて

います。

InformaCast のアップグレード

InformaCast のユーザはすべて、Basic InformaCast から開始して、[Try] または [Buy] アイコンから、

または機能を切り替えるためのライセンスを入手するために Singlewire に問い合わせることで、

Advanced InformaCast にアップグレードできます。

（注） InformaCast のすべての機能を最大限に活用するための Advanced Notification（高度な通知）に関して

は、『InformaCast Virtual Appliance Installation and User Guide』を入手してください。アップグレー

ド後に、[Help] > [Install Guide] から、または https://<InformaCast Server IP 
Address>:8444/InformaCast/doc/pdf/InformaCastAdvancedNotification.pdf にアクセスして PDF を取

得できます。アップグレードした際にオンライン ヘルプ（[Help] > [Install Guide]）を使用する場合、

ウィンドウを閉じ、再び開いてアップグレードされたヘルプを表示します。

Advanced Notification の試用版

[Try] アイコン（ ）をクリックすると、Advanced InformaCast の 60 日間の無料試用期間が開始し

ます。

ステップ 1 Basic InformaCast 使用中にいつでも [Try] アイコン（ ）をクリックできます。

サーバがインターネットに接続されている場合、フォームが表示されます。必要な情報を入力し、

[Submit] ボタンをクリックします。

サーバがインターネットに接続されていない場合は、Singlewire の営業担当者の情報が表示され、試用

期間中にサポートの登録をするために利用できます。[Start Advanced Notification Trial] ボタンをク

リックします。

[Singlewire InformaCast Software License Agreement] ページが表示されます。

ステップ 2 [I Accept] ボタンをクリックします。ウィンドウがリフレッシュされて、InformaCast のホーム画面に移

り、現在 InformaCast Advanced Notification の試用版であることが表示されます。
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Advanced Notification の購入

[Buy] アイコンをクリックすると、デモンストレーション、サブスクリプション、または購入済みライ

センスのいずれかから InformaCast Advanced Notification を取得する手順を開始します。

ステップ 1 Basic InformaCast 使用中にいつでも [Buy] アイコン（ ）をクリックできます。

サーバがインターネットに接続されている場合、Singlewire Software の Web サイトへリダイレクトさ

れます。新しいライセンスを取得するにはプロンプトに従います。

サーバがインターネットに接続されていない場合は、Singlewire の Web サイトにアクセスするための

スマート フォンでスキャンできる QR コードが表示されます。ここで、新しいライセンスを取得する

にはプロンプトに従います。

ステップ 2 「新しいライセンス キーを入力します。」（P.5-4）に進みます。

新しいライセンス キーを入力します。

（注） Advanced InformaCast の無料試用版の場合、この項をとばすことができます。

Basic InformaCast から Advanced InformaCast へアップグレードする場合（Advanced InformaCast の
無料試用版を除く）、InformaCast システムの様々な機能をアクティブ化するためのライセンス キーを

インストールします。

（注） Advanced InformaCast の無料試用版をご利用の場合、ライセンスが自動的にインストールされ、

InformaCast の [Manage License Key] ページ（[Admin] > [Manage License Key]）に表示されます。デ

モンストレーション、サブスクリプション、または購入済みライセンスでは、Advanced InformaCast 
にアップグレードするまでライセンスは Singlewire の [License Manager] ページに表示されません。

（注） ベル スケジュール、IP 電話とスピーカー数、Communications Manager クラスタ、そしてメッセージ

の確認はすべてライセンスキーによって制御されます。特定の機能にアクセスできない場合は、

Singlewire の営業担当者に問い合わせてください。

警告 （以前 Advanced InformaCast を利用していて）Basic InformaCast から Advanced 
InformaCast へ移行する場合、InformaCast は新しいライセンスのインストールにともなって再起
動します。適切なアップグレードの計画を行ってください。

ステップ 1 Web ブラウザを開き、https://<InformaCast Virtual Appliance IP Address>:8463/LicenseManager にア

クセスします。<InformaCast Virtual Appliance IP Address> の部分は、InformaCast EX の静的に設定

された IP アドレスです。

ステップ 2 [Login Name] フィールドおよび [Password] フィールドにユーザ名とパスワードをそれぞれ入力します。

デフォルトでは、ユーザ名は admin、パスワードは changeMe です。[Login] ボタンをクリックします。

ステップ 3 [Browse] ボタンをクリックし、電子メールで送信されたライセンス キー ファイルを選択します。ライ

センス キー ファイルへのパスを入力することもできます。
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ステップ 4 ライセンス キー ファイルを選択し、[Open] ボタンをクリックします。

ステップ 5 [Upload a New License] ページで [Upload] ボタンをクリックします。

License Manager は、Advanced InformaCast の試用版を利用している場合を除き、Singlewire のすべ

てのライセンスを保持します。使用中のソフトウェア アプリケーションによって、このページに表示

される格納されたライセンスは異なります。

ヒント キーが受け入れられない場合、ユーザに電子メールで送信された XML キーを含む適切なファ

イルを選択していること、IP アドレスが正しいこと、キーが期限切れになっていないこと、ラ

イセンス キーの MaxVersion パラメータがご使用の InformaCast のバージョンと一緒かそれ以

降であることを確認します。問題が解決しない場合は、Singlewire の営業担当者に問い合わて

せください。

トラブルシューティング

次の一般的な問題は、InformaCast で Basic から Advanced へアップグレードするときに発生する可能

性があります。

問題 （Basic から Advanced 試用版、デモンストレーション、サブスクリプション、購入へ）

InformaCast をアップグレードするとき、次のいくつかの問題に遭遇する可能性があります。

• ログインできない

• [My recipients]、[user accounts]、[dialing configurations] などが見つからない

• 過去に利用したことがあるブロードキャストが配信できなくなった

ソリューション ベーシック、試用版、デモンストレーション、サブスクリプション、または購入した

ライセンスを利用して、InformaCast を Basic から Advanced にアップグレードして、その後 Basic 機
能に戻す場合は、Advanced 機能で入力したすべての追加情報は保存されません。Advanced 
InformaCast への再アップグレードを行う場合、情報が再度表示されますが、Basic 機能に戻った後で

新しく入力した情報は利用できません。

この問題で引用された 3 つの例には、いくつかオプションがあります。

• ログインできない。Advanced InformaCast 利用中に、管理者パスワードを変更しましたか。変更

した場合、パスワードは Basic InformaCast を最初に利用したときのパスワードに戻っています。

そのパスワードをロギングに使用します。パスワードを忘れた場合、パスワードをリセットするた

めに Singlewire サポートに問い合わせてください。

• [My recipients]、[user accounts]、[dialing configurations] などが見つからない。Advanced 
InformaCast 使用中に [My recipients]、[user accounts]、[dialing configurations] などを追加した場

合、Basic InformaCast へダウングレードするとアップグレードの前の最後に入力した情報に戻さ

れます。この情報を再入力するか、Advanced InformaCast に再度アップグレードする必要があり

ます。Advanced InformaCast へ再度アップグレードを計画している場合は、2 度目に Basic 
InformaCast で入力した新しい情報は使用できないことに注意してください。

• 過去に利用したことがあるブロードキャストが配信できなくなった。Basic InformaCast に戻る前

に Advanced InformaCast で IP アドレスを変更しましたか。変更した場合、ブロードキャストは実

行できません。この問題を修正するには、InformaCast OVA を再配置する必要があります

（「InformaCast Virtual Appliance のインストール」（P.2-3）を参照してください）。
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第 5 章
InformaCast を Basic から Advanced へアップグレードする
問題 InformaCast をアップグレードしたところ、[Edit Telephony Configuration] ページでエラーが発

生します。

ソリューション [Edit Telephony Configuration] ページでエラーが発生する場合、フィールドに正しい

情報が入力されていることを確認します。次のフィールドの情報を確認します。

• [Communications Manager AXL User]。Communications Manager の管理インターフェイスにア

クセスし、同じユーザ名 /パスワードの組み合わせでログインします。ログインできない場合、

InformaCast にはログインできません。

• [Communications Manager IP Address(es)]。[Communications Manager Admin User] フィール

ドでも同様の確認をします。

• [Communications Manager Application User]。Communications Manager 管理インターフェイ

スにアクセスし、InformaCast のアプリケーション ユーザのクレデンシャルが Communications 
Manager のクレデンシャルと一致することを確認します。

• [SNMP Community Name]。ここで入力した値が Communications Manager での値に一致するこ

とを確認します。SNMP の機能を検証するには、SNMP_UpTime ツールを使用します。

問題 InformaCast をアップグレード /ダウングレードしたところ、[Admin Overview] ページの 
[Communications Manager Versions] カラムにエラー メッセージが表示されます。　　

ソリューション 電話機のキャッシュを再構築します。この問題は、ライセンスの変更およびクラスタ

の追加、削除、更新のたびに発生します。ライセンスまたはクラスタが変更された場合、変更を反映す

るために電話機のキャッシュを再構築する必要があります。電話機のキャッシュは 1 時間ごとに自動的

に再構築されますが、すぐに完了させたい場合は [Edit Recipient Groups] ページで [Update] ボタンを

クリックして、Communications Manager から現在の IP フォン情報を検出します。この作業が完了す

ると、Communications Manager の情報が [Admin Overview] ページに正しく表示されます。

問題 InformaCast をアップグレードしたところ、受信者のグループから欠落している電話機がありま

す。

ソリューション 電話機は、SNMP および AXL を使用して Communications Manager から確認できま

す。受信者のグループから欠落している電話機がある場合は、次の点を確認してください。

• Communications Manager の管理者アカウントに正しいユーザ名 /パスワード情報が設定されてい

る

• SNMP がすべての Communications Manager クラスタ ノードで有効である

• SNMP コミュニティ ストリングにすべての Communications Manager クラスタ ノードの読み取り

権限がある

• SNMP コミュニティ ストリングが、すべての Communications Manager クラスタ ノードで同じで

ある

• InformaCast サーバからすべての Communications Manager クラスタ ノードに対して UDP ポート 
161 がブロックされていない

さらに SNMP のトラブルシューティングを行うには、SNMP_UpTime ツールを使用できます。

問題 InformaCast をアップグレードしましたが、ログインして機能にアクセスしようとすると、

「Missing or Invalid Application License Key」というメッセージが表示されるページに移動します。

ソリューション ライセンス キーが受け入れられない場合、ユーザに電子メールで送信された XML 
キーを含む適切なファイルを選択していること、IP アドレスが正しいこと、キーが期限切れになって

いないこと、ライセンス キーの MaxVersion パラメータがご使用の InformaCast のバージョンと一緒か

それ以降であることを確認します。問題が解決しない場合は、Singlewire の営業担当者に問い合わてせ

ください。
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